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Hello, this is Eric Bobrow. And in this lesson, we'll create a site model for the building using the Mesh
tool as well as the Slab tool, and add a few trees as landscaping with the Object tool.

So here's the building as it stood at the end of the previous lesson. You notice that we've got the floor
plan and we have a furniture plan. These are some variations along with structural plans, etc., that are
different versions of what we are looking at. Now I'd like to create a site plan to work on the terrain
model. So I'll activate the floor plan here, and then switch some of the settings. So I'll go to the Quick
Options, which is this little button in the bottom left, third from the left in the navigation area. And I'll
switch the layer combination from floor plan to site plan. And that actually changes what is seen,
because layers determine which things are visible and which are not. And now we're seeing just the
walls, the exterior walls, and the roofs. And it turns off the interior of the building. [1:07]

Now if you're working with the international metric version, then you'll also have a site option. But
you'll need to change the layer combination to show the walls in order to coordinate the survey. And |
will repeat the exercise that I'm about to do with bringing in the survey again with the metric version.
So first we'll do the U.S. version, and then we'll repeat with the metric. So to bring in the survey, a great
way to do it, starting in ArchiCAD 11, would be to create a worksheet with the survey. Now, if you're in
ArchiCAD 10, or | can't remember when worksheets were introduced, maybe it was 12. So if you're in
ArchiCAD 10 or possibly 11, then you would usually create a new detail drawing to place this or possibly
place it on a story below the main one. So you can create additional stories in your project. [2:06]

But I'm going to go ahead and create a new independent worksheet, which has an ID. I'll just leave that
alone. But I'll change the name here to "Survey". It now gives me a blank drafting area. Now I'm going
to change the scale from 1/4 inch, which is 1:48 to 1/8 inch, because | figured that the survey will fit
nicely on my layout sheet at that scale. If you're working in metric, 1: 100 will work just fine, and of
course when you're working with very large projects, then you might have much smaller scales, 1:200 or
a 16th of an inch or even smaller. So I'll just say OK. And now I'm ready to actually bring in the DWG
from the consultant as a survey. [2:53]

So I'll go to the File menu, External Content, Place External Drawing. Now if you're in the Start Edition,
you won't have that option, so you might have to do things like merging the drawing. And | won't deal
with that in this lesson, but just follow along with the general principles, because you can still do similar
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sorts of things. So I'll say Place External Drawing, and it allows me to choose a DWG file. So I'm going to
go look here, and | have my site survey. It'sa DWG. Right now | have the filter saying show everything,
so all different types. You could pick from the filter to say only show DWG, and there would be a very
short list in this folder. I'll say Open, and when | do that, it asks me, what is the drawing unit?" [3:42]

Now what you've got to understand is that in DWG files, the elements are described based on how
many units in length or placement they are. So in other words, something that is a hundred units in
length aligned could be 100 feet, 100 m, 100 miles, anything. So we need to choose what that's going to
be. Now, if you're in the U.S. and you're working with the most common surveys, which are in decimal
feet, so the property line is described as 128.57 feet, then one foot would be the unit. If you're bringing
in an architectural drawing that is in feet and inches from a consultant, then you might pick 1 inch. In
metric, you can experiment between meters and millimeters. In the file that I'm supplying to use for this
purpose, you would be bringing it in as 1 m. [4:33]

So I'm going to choose the 1 foot and say Place. But now allows me to say where | would like to place it.
| will just click on the origin point of this drawing. It's a little bit arbitrary, but you can see that the
drawing just came into the upper right of it. And I'll do a Fit in Window, and we can see the site
boundaries. We'll also see some dimensions, 70 feet along the bottom, 100 feet along the right and top
edges, and if you're bringing in the metric file, then it's going to be | think 20 m along the bottom and 30
along the top and the right side. Now also, because this is for training purposes, I've put in some
numbers indicating heights above sea level. So 64 feet, 66, etc. We're going to put the building in this
area between 70 and 72. If you're working with the metric, | have numbers 20 m, 21 m, 22 etc. And so
we're going to be putting in and around 22 m in height above. We could say sea level, or perhaps you're
used to calling it something else, like in Australia it's called the Australian Height Datum or AHD |
believe. [5:42]

So in any event, the first job after bringing it in is to verify that it's the right scale, that it's actually the
right size, that it measures properly. So I'll click on the Measure tool, and I'll go to this corner here and
click, and go to the other corner. And we can see its 70 feet. Perfect, it matches. And if | want to just
double check, I could go up here, 100. Basically, this will either be perfect or usually, if it's not perfect, it
will be off by a factor. For example, if instead of 70 feet, it read a little under 6 feet, perhaps its 70
inches, and you'd need to bring it in again. Double checking that you're not setting it for inches, we need
to set the measurement unit to feet, 12 times as big, or the reverse. You might have something that's
way too big, and you have to bring it in again with a different scale. [6:33]

Now I'll hit the Esc key to cancel that, because the measurement was verified. Now you can see there's
a little guide here in terms of two lines and a text that says "Corner of existing building". So we're going
to use that as a way of locating the survey reliably to the new building, or the building that we've been
working on, which will go in this general area to the upper left of that corner. So I'll go back to the View
Map, and I'll double click on the first floor plan here. And actually, let me create a site plan, as | started
to do. So I'll go to the Quick Options and change it to site plan, and then I'll use the option at the
bottom of the View Map to Save Current View. [7:22]
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So I'll go here, and give it a name. If yours says by Project Map, and doesn't let you adjust the name, you
will have to change it to Custom, and then you can say, for example, site plan. And I'll just leave
everything else alone, all of these things of course could be adjusted, but I'll go ahead and create it. |
will make a note that it is using the correct layer combination, the one that is currently active in the
window, and I'll say Create it. So you see now there's a site plan here. | can of course just double click
on furniture plan or floor plan and see the variations. And then here's the site plan. Now, when we
return to the metric version, I'll explain a couple of differences that we need to make in the layer
combination for the site plan at that time. [8:09]

So in order to be able to see the site properly, we'll need to use the worksheet as a Trace Reference.
Now, one thing | forgot about is that in the worksheet clone folder, if | double click on that survey that |
brought in, we'll see the scale looks funny. The numbers are much smaller. Why? Because this view is
set incorrectly at 1/4 inch to a foot, or 1:48. So what | need to do is, with the survey view selected, go to
the settings. And in the settings and say no, it should be added 1/8 inch to a foot. If you're in the metric
one, it will probably be correct with 1:100, you won't have to adjust it. But you can see I've just changed
the settings, and now it's showing properly. [8:58]

So I'll go back up to the view that | created, the site plan view here. And having brought that to the
front, I'll now scroll down and right click on the survey and say Show as Trace Reference. Now, if you're
in ArchiCAD 10, then you would need to place the surveys on a lower story. In other words, create an
additional story, perhaps just for the DWG import. So then you can use Show as Ghost Story to be able
to see something similar to what I'm doing now. And when | say Show as Trace Reference, we'll see
some lines just barely visible right now. Let me just zoom out to Fit in Window. And you can just barely
see them. [9:44]

Let me go and open up the Trace and Reference palette here by pressing down on the popup menu next
to the Trace and Reference button. And I'll go and perhaps change the opacity or the level of the color
here. | can change the color if | want to another color. You can see this is now reddish, I'll just leave it at
the blue one, whatever you like. It's really just what will make it easier for you to see it and coordinate
with it. Now, obviously the survey is sitting somewhere in space, and | want to coordinate where it is in
relationship to this project. Now in theory, we could move the entire building over, but really, in
practice it's much easier and usually done to move the reference into proper relationship. [10:32]

So I'll use the button here that is called Drag Reference. So I click on that, and then I'll move my mouse
and get the checkmark right at that corner. If necessary, you can zoom in to make sure that you're on
that corner. And then I'll move this over. And | may even zoom in here, and just make sure that I'm
placing it right on that point. Now if it was off a little bit, you would see those lines not directly
underneath the wall. So now we have - and I'll just Fit in Window again - and now we have the building
in relationship to the site. Now the site is going to be created using the Mesh tool. So the Mesh tool is a
tool that starts out creating a flat element like a slab, but then can be varied in terms of its height and all
the points on the periphery as well as the interior to it. [11:22]
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Now it goes on a layer. In the U.S. version it's L- Site. In the international version it would be something
with a Terrain Modeling | believe. But the layer, in this case, | don't need to adjust. Now | will need to
make sure that it's in the polygon method as opposed to rectangle, because this is not a rectangular
shape. Now, in order to set this properly in relationship to the building, let's just discuss for a minute
what height this building is going to be at. In other words, in relationship to the sea level or the height
datum, what should it be at? Well in the U.S. version, were going to set it between 70 and 72 feet
would be the natural grade. So I'll say that 71 feet would be a good finished floor height. [12:09]

And as it will turn out, it will fit above prevailing grade in the front, but be dug in a little bit into the
grade in the back. And we'll look at how we can actually clear out some space so the door can open and
things like that. Now in the international version, here you can see the 22 meters, this line here, and 21
meters. And of course, these are not exact equivalents of the American versions here, but they're
reasonable for training purposes to use these numbers. So for the international version, we'll say that
the finished floor is going to be at 22 m off the height datum or the sea level. [12:51]

So in order to sort of lock that in, in other words to tell ArchiCAD what that is, I'll go to the Options
menu, Project Preferences. So this is something that is set for the project, usually once. And you may
adjust it if you need to, but in general, it will just remain with the project. Each project will have some
levels that it will record. Now in ArchiCAD 15 and maybe 14, the north position is also part of this
command, but in earlier versions, it may just be the levels that you're sitting. Now, when we look at the
Levels and Project North command, in addition to the north arrow position, which we don't need to look
at right now, we have something called Sea Level. [13:37]

Now if you are in the international version, it may be reference level one or reference level two, and you
can change the name to, for example, AHD for the Australian Height Datum, or the word Sea Level,
whatever you prefer. I'm going to say that sea level, this reference height, is 71 feet below the Project
Zero, which will be, in this case, the finished floor level of the ground floor. So I'm now setting up a
relationship between these. So what I'm doing in grading, | can refer to the exterior reference of sea
level or the height datum. Whereas when I'm working on the building, | can refer to distances from the
finished floor of the main floor. So I'll set that, and we don't see any change here, but it does allow us,
when we put in the mesh, to set it in relationship to sea level or the height datum. [14:31]

Now I'll go click on the Mesh tool settings, and now we see Mesh Default settings. And let's take a look
briefly at what we have. We have a thickness. Now this is an initial thickness of this platform that the
building is going to be set at. And then we have a height reference, basically say where is the top
surface, at least initially going to be? Now initially it's saying zero for the current story, and it's telling
me that in relationship to sea level, its 71 feet above, because obviously Project Zero is 71 feet or 22 m,
22,000 mm above that. If | switch it to Project Zero, you can see that | can refer to that. But let's leave it
at sea level and say you know what, | would like to set the Mesh so that at the lowest point on the site,
which is just under 64 feet, 63 feet let's say, that the platform is just a little bit below that. [15:29]

So I'll say that it will start at 60 feet. So basically, the platform will be below the building, and then I'll
raise the top up to match the grade that it should be. Now if you're doing the metric one, you might
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want to try something like 19,500 for that or 19.5 m. So if you're working in millimeters, it would be
19,500 that you would want to put in here. And you want to make sure that this is set to sea level or the
height datum reference. So, there are some other things that we'll look at later. I'm going to make sure
that the mesh actually has a thickness. This is one of the options as opposed to just being a skin, sort of
like a piece of paper. And then this would be like a tin can it would basically have an outline, but would
not have anything inside it. [16:19]

So we'll leave this alone, and we'll look at these other settings later. So I'll say OK, and I'm going to start
drawing it. And remember I'm polygon mode, so | can click on a corner and then another corner here,
and another corner, and another corner. And if | want, | can go back to the first point or | can click on
this point up here, and it will close it, because it has to be a closed shape, it will return. Now if | select it,
and | can do that by holding down the Shift key to get the arrow and clicking it, you'll see that we've got
this thing selected. Let's go to 3D just for the heck of it. So when | go to 3D and we take a look, you see
that there is the shape of the site. And if | orbit, we'll see that the site is actually well below the
building, but not a huge amount below the building, just a little bit below. And it's flat. [17:15]

So now we're going to start actually making the mesh have some height difference. And so I'll go select
it again, and I'm going to start adjusting the heights. So with the Mesh tool, we can go to individual
node points like this corner here, and instead of adjusting that point or moving other things around,
there's a unique to the Mesh tool there's this Z Height operation. So when | select that it says, "What
height is this?" Well, it's going to be 63 feet relative to sea level. If you're looking at one of these other
things, then you would want to switch it to the height datum or the sea level to be able to put it in more
conveniently. Now we don't want to say apply to all, we just want a one point at a time right now. So I'll
just say OK. And if you're doing it metrically it would be 19,500 there. And now I'll go to this one, and
you can see on the actual survey that it's between 70 and 72. So I'll just call it 71. [18:15]

And if we were to do the metric one, it would be between the 21.5 line and the 22, so you would call it
21.750. And I'll go up to this upper one here, and this one's going to be 85 feet or a 25 1/2; 25,500. And
this one, if | calculate this by looking at the lines, it's between the 76 and the 78, so it would be 77 feet,
or it's just above the 23, so it would be 23.50. Now if | deselect this and go to 3D, I'm just hitting F3, you
can see now it's got a wedge shape. And if | spin around, you can see the building is slightly buried in it.
Well, it ends up being a little bit buried, but we have some interior definitions that | haven't even started
to do. But this is a very good way to start working with the mesh is to set the initial heights to get the
prevailing grade, the general estimate of the grade. [19:14]

Now let's go and start to create a little bit more detail. I'm going to select this again, and I'd like to start
with doing the two contour lines that are near the building, because those are the ones that really
matter. The other ones are just for context. And you can fill in as many or as few as you find useful.
Now I'll go to the edge and press down, and say that I'd like to add a point. Now, I'm not actually going
to move this point around, I'm just going to click back on that point to make another node point that can
be set at a certain height. And I'll do the same thing over at the other end; I'll just click, and click again.
It remembered that | was on an edge and | wanted to add points. [19:59]

5 Best Practices Course — Week 12 Part 1 — © copyright 2012 by Eric Bobrow



Now I'll go to either one of these that | just created, press down and use the Z height option, which
perhaps you may have to adjust which choice it is. Mine remembered that | was last working on the Z
heights. And I'll say well, its 70 feet above sea level. Again, just the individual point for this would be
21.5 or 21,500. And I'll do the same thing with this, and you see it says 68 because it's approximating it
between these two 22 points, but we'll say no, its 70 feet, and again 21,500. And let me do the two
points along this edge. So I'm going to go and click and create a new node point, and click on the other
end, click to create a new node point. [20:45]

And then once I've created those, when | press down, use the Z height option and say this is going to be
72. So this is actually adjusting it quite a bit, it's a little more flat in the lower part of this site. Or that
would be 2,200 and again, 72 for this end or 2,200. So now, if | go back to 3D here, we'll see that it's
adjusted a little bit, because I've got the edge a little bit more defined. And if | turn off the Orbit mode,
and | select it, if you can see there's some extra handles that now have some height definitions that
define the grade a little bit more precisely. Now, we're going to actually create some- we're going to
follow along the contour next. [21:36]

So I'll select the site, and this time I'm going to click inside. Now this contour goes from end to end, but |
cannot start a contour line in terms of ArchiCAD's definition by clicking on an edge. | have to click
somewhere inside it. So I'll just click somewhere inside on this. And I'm going to approximate it. It's
going to be a series of straight segments. And | can just do a handful of them, | don't have to do a huge
number, because it's really just context, it's not even near the building. But it will definitely set a
contour line. Now the last point, | could go on the edge, or | could stop just short, or | could go a little
beyond. I'll just go to the edge, and then one more click will say I'm done with this particular contour
line. And this says, "How would you like these new points to be fitted in?" I'll just leave the default
alone, which is to fit to the existing grade, where the ridges are, and then later I'll adjust the height.
[22:34]

In fact, I'll go now to any one of the interior points, press down, use the Z height option, and here, | do
want to say its 70 or what would be 21,500. Apply to All. | do want that to be done, because that will
apply to all of those points that | just created. And I'll do the same thing. I'll create a series of points.
Mesh tool is active; the mesh is selected, that's critical. And then | can click on a series of points along
here. And click on this last point an extra time, and say OK. It's created a few points. And then | can
press down on any one of the points that | just created and change this to 72 feet or 2,200 mm. And
apply to all. Now if we look at this in 3D, we're going to see it adjust a little bit more. An in fact, if | orbit
down here, we'll see that those points that | just created are level. They are actually contour lines with a
uniform height. [23:49]

So let me go back to the floor plan, and we'll just add one more just for good measure. So I'll go and

let's say pick maybe the 80 foot line, 24 m. And again I'll click on the end to add a new node, click on the
other end of the same one, and add a new node point. And then, with pressing down on the node point,
I'll use the Z option to set it to be the 80 feet, but not apply to all, or 2,400 mm, and the same here. And
then I'll create the points in between. So in order to create these points, | need to - let see. If | do make
a mistake here, and | just forgot, | can add extra points in afterward. It's not a problem. Or | can use the
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Backspace key is to go back. So this is, on a Mac it would be the Delete key, on Windows it would be the
Backspace key as opposed to the standard Delete key. [25:02]

But this is true for any polygon that you create, is when you're creating a series of points, if you make a
mistake on one of them, you can usually go back a step using that key. So I click on the last point, and
say OK, and then press on any one of these points, and change the height. So this is going to be 80,
apply to all, or 2,400 mm or 24 m. Now you're seeing a bunch of these lines here. This is what ArchiCAD
is actually building. It's creating a series of triangles. It's sometimes called the TIN or Triangulated
Intermediate Network or something like that to create that. [25:48]

Now of course, these are really not useful to us visually here, they really get in the way. So let's turn
that off. I'll go to the Floor Plan And Section with the mesh still selected, and there's an option here
whether to show all ridges or to show User Defined ridges. And then what | do that, you can see that
the terrain only has those lines, it doesn't have all the intermediate. Now when | go to 3D, you'll see a
slight change again with the new one that I've got. Now if you're in the international version, you may
find that there is an option turned on for the modeling, and that is that it's showing all ridges sharp. I'll
show you what that looks like. It will look similar in the 3D view as what | was just doing. And if we say
all ridges smooth, then it will just show the ones that are defined carefully. [26:50]

So that of course is going to be a little bit more satisfying for most purposes. Now you notice that these
points the contour lines are actually not quite going to the end. It doesn't really matter, but if you want
to, you can go, even in the 3D view and use the Reposition Node in the pet palette and snap it into
position. So you can't start those points on the edge, because ArchiCAD only knows that you want to
create a contour line or interior reference points when you click inside. But you can move them to the
edge afterward. So that's now nice and neat. So, let's just look at how the sections of the building are
looking, how this building is situated. [27:42]

So if  double click on a section here, we'll see that as it renders it with the terrain, that the building is
seated in the ground, and of course we need to excavate down from that. And I'll go to the other
section here, and we'll see something similar. Now it turns out that | can use Solid Element Operations
to manage this very easily. So | go to the Design menu. Now if you're in ArchiCAD 15, it's under the
Connect submenu, Solid Element Operations. If you're in previous versions, it would just beat directly
under the Design menu, fairly near the top, about a quarter of the way down as | recall. Now this may
have the full length here. We don't need to have the maintain operations, that would be to turn off
some of the work that we've done, or to disable the relationships between elements. [28:36]

But in this case, | do need the new operation. I'm going to go select. I'll press down the Shift key, and go
to the edge of the slab here. So this slab, which we're seeing part of, and you can see some handles
indicating beyond the cutting plane it extends further, I'm selecting that as the operator. So it's going to
operate on the other element, which will be the target. And the other element, and by the way I'll click
in empty space to deselect it and hold down the Shift key and click on the mesh, I'm going to make it the
target. So you select the element or more than one element, and then you click on get operator or get
target. [29:17]
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Now the operation here is subtraction, which will take out everything where they intersect, so that the
slab has a space to exist in the earth. But also with upward extrusion, that will clear out the space above
the slab which would include the walls and the interior volume, the air space in the building. And I'll say
Execute. You don't have to worry about this New Surfaces, because we are not going to see the surfaces
of the target anyway, it's going to be buried. But I'll say Execute, and you can see that it's beautiful.
Look at how that looks. Now let's go to the other section, and we'll see, look at that. It did the whole
work for us. [29:59]

And when we go to 3D, we'll see a slight difference. You can see that the Terrain Mesh now has a
boundary matching the building, because it's been temporarily cut out. And what | mean by
temporarily, if the building footprint were to move in any way, the cutout would just adjust, because
Solid Element Operations are something that will stay live and adjust as needed. [30:26]

Now I'll just hide this a little bit. I'll hit the little triangle to say make it just a small compact palette while
leaving it around. And let's look at how we would do some hardscapes. So actual slabs for flat patios or
walkways and things like that. Now to see this, if | zoom in, we'll see that the doorway here could work.
In other words, the prevailing grade is a little bit below the doorway. So we could allow that. And if |
orbit around here, we'll see that on this side, it also, the door is still being seen. But if | orbit around
further, and then let me turn off the Orbit, and just use the center mouse button to pan down, we'll see
that we do have a little bit of a problem in that the door is buried here. And likewise this door. So in
other words, in the back of the building, we need to excavate down. [31:28]

Now if we are excavating down, we're going to need to put a new surface in there. So let's call this a
patio or some type of utility area for recreation or utility. So I'll go to the floor plan. And let's say that
we want to put, and I'll just zoom in a little bit. Let's say that we want to put a slab here for that patio.
So I'll go to the Slab tool. Now I'm not sure what the Slab tool settings are, so I'm going to go and use
the eyedropper. So I'll use the eyedropper here, and I'll hover over where the other slab is. You can see
as | move over it, it says, you're looking at the slab. Because | have the Slab tool active, it will prefer
picking up the settings of the slab rather than the walls, which is just perfect in this case. So I'll do that.
[32:19]

Now, this slab will have the same thickness and same elevation of the interior one. | might want to
adjust it. | can do that afterward. And of course, | might want to put a different material onit. So I'll go
ahead and create a rectangular shape here by clicking these two corners with the rectangle one, and
then I'll select it. I'll hold down the Shift key and click on it. And perhaps I'll expand this. I'll use the
option here in the pet palette to adjust the overhang and perhaps take this is 6 feet further out just to
make it have a nice distance. And as | recall, the utility room door here also needed to have some
clearance. So I'll extend that as well. I'll go to a corner or an edge and use the Boolean Addition and
then go and click a rectangle here. And that will extend all of this. [33:12]

Now, if | go back to 3D right now, we won't see that slab, because that slab is buried. So in order to be
able to see it, I'll go back to the floor plan. And by the way, I'm hitting F2 and F3 to go back and forth.
Or you might need to use the Function key on the Mac, depending upon your settings to be able to use
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the Fn keys, the function keys. Now I'm going to select this slab that | just created, and | will open up the
Solid Element Operations palette again. And say that it's the operator; it's going to control the action.
And let me just zoom out a little bit, and having done that, I'll click outside it, and then I'll select the
mesh, and make it the target. And again, use the same command, Execute. And look what happens
when | go to 3D. There, it cut a hole in the ground, and | can go and select this and perhaps change it to
a different material. [34:16]

So if I scroll over, you can see here are the materials, we can look at the top, the edge, or the bottom
surface. All | really care about is the top. Of course in some cases, you might want to put them all as the
same material, but I'll just look at the top and pick from the popup. Now let me just pick one of the
stone ones. It's really arbitrary; just pick a material that suits your fancy. You can always change it and
see what it looks like. I'll just pick that and okay, it looks pretty good. | like that. [34:48]

Now if | go to the floor plan, you don't see a change here, but what I'd like to show is that there's an
option, if | select the slab, there's an option to adjust how it's going to be seen on the floor plan that we
may not have looked at in previous lessons. And that is, when | have that slab selected, and | go to the
settings for it, | can turn on what's called a "Cover Fill". This option is available for slabs as well as roofs,
and mesh elements as well. And so when | turn that on, you can see that immediately, it gets a fill. So
this actually is not a separate fill element like the boards were in this bedroom, it's actually connected to
the slab. So if | change the shape of it, it would update at the same time. And right now is says, "Use fill
of surface material". And we could also turn that off and pick an arbitrary fill, just whatever we want for
that. So that's a nice feature. [35:51]

So we'll finish up the terrain modeling by putting in some trees, and then we'll return back and look at a
couple of variations that are required in the international version. So when | go to the Object tool, I'l
double click on the Object tool to open it up. That's one way to do that. And I'd like to get some trees.
So I'll go change from Folder view to Find Library Parts, and type in "tree", and then click find. And you
can see that there are a bunch of trees. Let me just bring this up so you can see everything that I'm
seeing. [36:26]

And you can see some ones that say "Tree Elev". This means this is a line drawing that you could place in
an elevation. Some that are simple, some that are more complex. And then there are ones that are
actually 3D, as we get down into three deciduous, or evergreen, or things like that. I'll pick let's say this
one here, which is a fairly simplistic one that we can use. And when | activate it, just like any library part,
it has a certain size. We could adjust that, but that's, in this case, the horizontal and vertical size on the
plan. And then there may be some settings in terms of the height of the Object. [37:07]

If we look in 3D, we can see what sort of tree it's going to be. And we could adjust that. And there are
all sorts of settings for how it's going to look on the plan. In other words, if | change it to a different one
of these options here, we can get different effects. So pick the one that suits your preference, and then
we can just click OK. Now, when | place it, of course the grade is much higher in the back corner here
than it is down in the front corner on the opposite diagonal, and | would like ArchiCAD to actually look at
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the height of the terrain and place the tree right on top of it. So that's possible using the little Gravity
icon here. [37:53]

So Gravity is just to the right of the Trace and Reference palette, and | can go press down here and say
that I'd like to gravitate to mesh. And we could put things on top of a roof or on top of a floor slab, but
I'll say the mesh, that's the terrain. Now if I click on this, you can see here it's not active, here it is. So
now what it will do is it will actually, as | move my mouse around, it will actually place the tree or
whatever element I'm drawing, it could even be a wall at that height. So I'll click, and click again to place
it. Let me just say that I'd like to place it straight, that | don't need to rotate it, and I'll go and place
another one here, and I'll go and place another one say down here. [38:38]

Now if | select this one, you'll see that its base height is minus 4 feet 8. So that means is 4 feet 8 or about
1% m below the floor. Over here, it's at 2 feet 2 above the floor, so it's gone up 600 mm. And this one is
way up at 11 feet or 3 or 4 m above. So if | go to 3D, we'll see, and if | zoom out a little bit, we'll see
these trees. And I'll just spin around with the Orbit; they are rather different heights, because they
automatically found their position. An in fact, we can actually put in the tree right here in 3D. | can
click, and you can see it actually puts the trees, let me just undo that. Let's just put this tree perhaps in
this side. [39:32]

So you can see how it finds the grade whether you're in 2D or 3D. So that concludes the lesson on
terrain modeling, except that | want to go back and show you how it works with the metric version.
There are a couple of key differences. So let me just switch over to the metric one. And so, as you
recall, and this would be a good review for people in the U.S. as well, just to see how it's done a second
time. I'll go to the worksheet and create a new worksheet. So I'll say - actually | can't do it here in the
View Map, | need to be in the Project Map, and then in the worksheet. So | can say New Independent
Worksheet, and then let's just do that again, and just change the name to "Survey". [40:24]

And then here we are in 1 to 100, so | don't need to change the scale, I'll just go to the File menu and say
External Content, Place External Drawing. And I'll go find the metric file which is the QuickStart Site
Survey for International. And here, | need to change the drawing unit, or verify that it is set properly. In
this training example, it will be set for 1 m, or that will give you the correct results as opposed to mm.
And I'll say place. And again, | can just click somewhere to place it, and it comes out. We'll just Fit in
Window. [41:02]

Now, its placement is sort of arbitrary in the sense that right now the center is where it is, rather then
the corner. That's something that you can adjust. In fact, I'm just going to go ahead and move it so it's a
similar relationship to the origin. Really, it doesn't make very much difference in most cases. So you can
see a very similar graphic, although it's resized the bit to make nice even metric sizes. | will verify of the
distance, I'll click on this point and that point with the Measure tool, 20,000 mm, and this one is 30,000,
and 30,000, etc. I'll hit the Esc key, and that looks nice at this point here. [41:43]

Now there is a boundary you can see around this, that's visible under the View menu. If I go to
Onscreen View Options, | can say turn off drawing frames, and then you can see that goes away. That's
really optional, View menu, Onscreen View Options, Drawing Frames. Turn it on or off as you like. Now
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I'll go back up to the floor plan here, and | had left out the step of creating a site drawing. So we'll open
up the Quick Options, and we'll change our layer combination here to site. And when | do that, it turns
off the interior walls, but it actually turned off the exterior walls as well. [42:23]

So what | would like to do is modify the layer combination. Go to the Document, Layers, Layer Settings;
or Command+L or CTRL+L, and then you see I've got the site layer combination active, but | would like to
be able to see the Structural Bearing layer turned on, which is what the exterior walls are on, as
opposed to the interior walls, which would be the Interior Partitions. So I'm just going to turn on the
exterior walls. And now | actually forgot one thing, | need to go back into that command here. Very easy
to forget when you're moving quickly. | click on site, and | need to adjust again, the structural bearing,
and then click update. [43:10]

Very important. If you don't do that, it will forget it the next time you double click on the view or change
the layer combination there. So you need to update and click OK. So now we're seeing something
similar to what we had before in the U.S. version of the walls showing as well as roofs. Frankly, | could
do without the roofs, but its fine, we can leave those turned on. And let's go now to two create the
terrain model. So it's going to be very similar. I'm going to go and first double check that in the
worksheet clone folder that the survey looks correct. [43:46]

And when | double click on it, it looks fine, because its settings here were set at 1:200, which was
correct. Whereas in the U.S. version, | had to adjust that. So I'll go back down to the floor plan, and
again | forgot one thing. | need to go and set up the site layer combination, and go and use this button
that says Save Current View. And, again if you have it saying by Project Map, you can't adjust it, you
need to change it to Custom, and then we can call this "Site Plan", and all the other settings can be left
alone, since we are set at 1:100. And I'll say create. [44:24]

So now if | double click on ground floor site plan or furniture plan, we'll see all these different variations.
So I'm in the site plan, and I'm going to go to the Mesh tool. Now before | place the mesh, remember
that | have to go to the Options menu, and go to Project Preferences, Levels, or Levels and Project
North. And here, you see it says first and second reference level. It doesn't matter which one of these
you use. I'm just going to call it "Sea Level - AHD", for the Australian Height Datum. So whatever you
want to call it. And what height is this is going to be? It's going to be -22,000. So 22,000 mm, or in
22.000 if you're working in meters. Because that's the height of the finished floor that I'd like to use.
[45:14]

Now, I'll say OK. We don't see any difference here. But now when | open up the Mesh tool, and we look
at its settings, and | just double clicked on the tool to open it up. Here's the thickness of the initial
platform, and I'm going to pick a reference of the sea level, AHD, and say that, you know what, this is
going to be at a height of 19,500. Now I'm going out of order here a little bit. So let me just recover my
steps. | need to show where the survey is. | need to bring that in. So I'll right click on the survey and say
Show as Trace Reference. And we'll see this showing up in a rather faint view, so let me go and open up
the Trace and Reference, and then change the color perhaps to the blue, and maybe make it a little less
pronounced. [46:11]
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And perhaps the grid here is not really helping me, so I'll go and under the View menu, turn off the Grid
Display. And you can see that's a little bit easier to make out. Now remember, we had adjusted the
position of the reference using the Drag Reference button here in the Trace and Reference palette. And
I'll go and click on the corner of the building in the survey and zoom in enough before | do this to get it in
the right place. Now if you get it in the wrong place, it's not a problem. You can always drag the
reference. Again, just drag it as many times as you need to get it in the perfect position. [46:46]

So now, and I'll take this a little bit darker so we can look at it here. So you can see here's the 20 m 21,
22, and that's what we're going to focus on. So I'll go with the Mesh tool, and from here on it should be
about the same, with one exception. I'm going to go and put in this mesh, which I've already set to be at
19,500 for the base, and I'll finish it. Now you notice that it actually has a cover fill, which we had seen
when | added the patio slab. So what | need to do is actually turn that off. | least | think it's distracting
for this purpose. If we zoom in a little bit, you'll see that it's supposed to represent this grass fill. So I'l
just Fit in Window, and we've got the mesh actually selected. [47:38]

So | can simply go to the Floor Plan and Section here, and turn off the Cover Fills. So that will make it a
lot easier to work with. So basically, the rest of the exercise is exactly the same as what | was
demonstrating. We had to adjust the layer combination for the site layers in order to be able to see the
walls for alignment of the survey. And the terrain mesh is actually on a layer called Site and Landscaping
Terrain. And then when we go to the Object tool and put in the trees, then we will need to switch the
layer from Interior Equipment, which it was last use, we'd use the Site and Landscaping General
probably would be a good option for putting the trees on. [48:33]

So other than that, everything else should be exactly as | demonstrated. So this has been Eric Bobrow,
and this concludes our lesson on terrain modeling using the Mesh tool the, Slab tool and the Object tool.
| look forward to reading your comments and questions on the page down below. Thanks for watching.
[48:56]
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